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Reporting on a Model Portfolio’s ESG scores 
 
 
Now that you have done your created your Model Portfolio, what better way to report on its ESG scores to your internal 
or external audience than by using Presentation Studio? 
 
You want to create a factsheet to report on your Model Portfolio’s ESG scores, product involvement and carbon rating 
using Presentation Studio. 
 
Should you require to distribute those reports to more than 25 people internally, or to an external audience, please talk 
to your Customer Success Manager or Sales Representative at Morningstar about a distribution licence. 
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Presentation Studio allows you to create professional, custom-branded factsheets and 
presentations, appropriate for all of the audiences you reach. 
Before working with one of the Morningstar Templates, we will check our settings. 
To do so, do the following: 

1. From the navigation panel, click Presentation Studio. 
2. From the top-right corner of the Presentation Studio landing page, click the Gear icon 

. The Application Settings dialogue box opens. 

 Note: There are multiple tabs to go through. Today we will only go through a few of 
them. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. On the Data tab, using the drop-down menus, set Display Benchmark 1, Display 
Benchmark 2 and Display Benchmark 3 to your preferred options. In this instance, 
they are set to the Morningstar Index, the MPT Index and the Morningstar Category 
Average respectively. 

4. Using the magnifying glass, set the Risk-free Rate to your preferred risk-free rate. In 
this instance, it is set to Euribor 3 Month EUR. 

 Note: You may decide to leave them on the default and to choose the benchmark of 
your choice when creating a new report. 

5. Set the Default Currency to your preferred currency. In this instance, it is set to Euro. 
6. Click OK to save your settings. 
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We will use one of the Morningstar Templates to report on our Model Portfolio’s ESG 
scores. 

To do so, do the following: 

1. From the Presentation Studio landing page, click the Morningstar Templates tab. 
2. Expand the Factsheets section and double-click on Sustainability Factsheet (Custom 

Portfolio). 

 Note: If you are on an lower version to the one the template was created with, the 
template will be greyed out. You can still open it by hovering over the template and 
clicking the 3 dots, then click Save As > A Duplicate Copy. The template will then be 
saved under the My Templates tab and you can then double-click on it to open it. 

 Note: By doing so, you can still access the template, but any component from a more 
recent version will not display. 

3. The Investments: Settings dialogue box opens. 
 
 
 
 
 
 
 
 
 
 

4. Click on the magnifying glass. The Find Investment dialogue box opens. 
5. Using the Universe drop-down menu, select Model Portfolios. 
6. Type “My Portfolio” (or the model portfolio name of your choice) and click Go. 
7. Select My Portfolio (or the model portfolio of your choice) and click OK. 
8. Under Display Benchmarks, click the magnifying glass next to the 1st benchmark. 
9. Using the Universe drop-down menu, select Custom Benchmarks. 
10. Type “My Benchmark” (or the custom benchmark name of your choice) and click Go. 
11. Select My Benchmark (or the custom benchmark of your choice and click OK. 
12. Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 

The report opens. 
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Since we are using a Model Portfolio and a Custom Benchmark, each component will 
need to calculate the data, and this will take a few minutes. In the meantime, we can 
work with the Workbook Settings to apply some modifications to our formatting. 

 Note: If the calculation does not occur, click the Calculate button on the toolbar and 
click Workbook. 

1. From the Home tab, click Workbook. 
2. Click the Layout tab. 
3. Under Component Title Settings, set the Bar Style to a thin line and the Background 

Colour to dark blue (1st colour from the top) or any other colour of your choice. 
4. Set the Component Title Settings Font Size to 14. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Note: on the later versions of Morningstar Direct, you also have an option to change 
the Page Orientation of the report from Portrait to Landscape. If you do not see this 
option, you will be required to upgrade Morningstar Direct. 

5. Click OK. 

Your changes are applied to the report. 
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Once the report is calculated, and before making further modifications, let’s save the 
report. To do so, do the following: 

1. Click the Gear  icon to the left of the Home tab. 
2. Click Save. The Save As dialogue box opens. 
3. Type “My Portfolio – ESG Scores”. 
4. Click Save. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
You know the report is saved when the title appears on the title bar at the top of the 
window. 
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We now want to apply certain changes to the first page: 

 Delete the space to the right of the Sustainability Score chart. 

 Note: 3.20.4 is the version the template was created with. If you use a lower version, 
the component will not display the Sustainability Score chart, but an empty space 
instead. 

 Note: You could instead add the Time Series chart and display the Historical 
Sustainability Score data point. 

 Display values on the Risk Score Variables bar charts components present on 
the page 

 Remove the tables below those charts 
 Save the custom text “Portfolio” and “Benchmark” as customised components 

for use on other pages. 

To proceed, do the following: 

1. Click the empty space to the right of the Sustainability Score chart. 
2. To remove it, press the Delete key on your keyboard. 

 

 

 

 
 
 
 
That space is now removed, and the chart takes the whole width. 

Let’s now save the Portfolio and Benchmark custom text components for use in other 
pages later on in this exercise. Any component that you modify can be saved as your 
own component, saving time and making it easily available to other pages in your 
report, as well as other reports you will create. 

To save a component, do the following: 

1. Click the Portfolio text box. 
2. Right-click and click Save to My Components from the menu. 
3. In the Component Name field, type “Portfolio title”. 
4. Click Save. 
5. Click the Benchmark text box. 
6. Repeat steps 2 to 4 but naming the component “Benchmark title”. 

You can access your saved components by switching the component section to My 
Components on the bottom-left corner of the report window. 

Exercise 5: ESG Risk 
Overview 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Saving a Component 

 

Click the space 
and press Delete 
key 
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To add values to the Risk Score Variables charts, do the following: 

1. Click the Portfolio ESG Risk Score Variables chart to the left of the page to select it. 
2. Right-click the chart to bring up the menu. 
3. Click Show Values. The values now display on the chart. 
4. Click the Portfolio ESG Risk Score Variables chart to the right of the page to select it. 
5. Repeat steps 2 and 3 above. 

 
 
 
 
 
 
 
 
 

 Note: Portfolio ESG Managed Risk Score is the asset-weighted average of the 
company managed ESG risk scores for the covered holdings in a portfolio. Company 
managed ESG risk Scores from Sustainalytics measure the degree to which a company 
effectively manages risk driven by ESG issues. ESG issues must have a potentially 
material impact on the economic value of a company to be measured. The managed 
ESG risk scores are displayed as a number between 0 and 100.  

 Note: Portfolio ESG Risk Exposure Score is the asset-weighted average of the 
company ESG risk overall exposure scores for the covered holdings in a portfolio. 
Company ESG Risk Exposure Scores represents the overall exposure score from 
Sustainalytics calculated by adding a company's corporate governance exposure score 
to the sum of its issue exposure scores which reflect exposure for a given subindustry 
and the company specific beta assessment. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Showing Values on Charts

Add Values to 
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To delete the tables below those charts, do the following: 

1. Click the table just below the left chart. 
2. Press the Delete key on your keyboard. On prompt, click Yes to confirm deletion. 

 

 

 

 
 
 
 
 
 

3. Now that you have an empty space, press the Delete key on your keyboard to 
remove that space. Press again to remove the other spaces. 

4. Click the table just below the right chart. 
5. Repeat steps 2 and 3 to remove that table as well. 
6. You can now resize the charts, so they take less space and bring the tables 

below slightly up. 
 

 
Controversy Coverage displays the Percent of AUM Covered in terms of controversy, 
as well as the number of securities scores and not scored. 

Controversy Distribution displays a breakdown of the Percent of ASM Covered in 
terms of controversy from no controversy to severe controversies. 
 

Click Yes 
to confirm 
deletion 
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The following page displays the top 25 stock holdings with their ESG Risk, Risk 
Exposure and Managed Risk scores, Peer Group, Classification, Rating Date, and 
Controversy information. 

Please note that this information will only display for company-level risk data if you 
have the appropriate licensing in place for Sustainalytics data access. 

If you do have access, you could decide to hide the cash holdings displayed in this 
component. To do so, do the following: 

1. Click the Top 25 Holdings ESG Risk Scores table. 
2. Click Table Settings at the bottom left corner of the window. The Portfolio Holdings 

settings window opens. 
3. Under the Table tab, deselect the checkbox Include Cash Holdings. 
4. Click Calculate on the table. The cash holdings have been removed. 
5. Click the Top 25 Holdings Controversy Scores table. 
6. Repeat steps 2 to 4. 

 
If you do not have access to the company-level add-on, you can then remove the page 
from the report. 

1. On the left navigation panel, click on page 2. 
2. Right-click page 2 and click Delete. 
3. When prompted, click Yes to confirm the deletion. 
4. Click the Gear icon in the top-left corner of the report and click Save. 
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Removing Cash Holdings from 
the Portfolio Holdings 
component 
 
 
 
 
 
 
Exercise 7: Deleting a Page 
from a report 
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Let’s now move on to the Sustainability Report: Fund Holdings page. 
Here you will find the top 25 fund holdings with their Sustainability Score, Risk 
Exposure Score, Managed Risk Score, Global Category, Sustainability Rating Date, and 
Controversy Percentage of AUM. 
 
 
 
 
 
 
 
 
 
 
 
For instance, here we notice here that Fidelity Special Situations has the highest 
Sustainability Score. 
 
 
 
 
 
 
 
 
 
 
 
And we see here that it has mostly moderate controversies. 
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We will now apply modifications to the Product Involvement page (the new page 2). 
We want to simplify the page to compare the fund and benchmark only, and we want 
to add intentional attributes to check if the fund manager is employing any exclusions 
from those products, allowing to check this information against the Product 
Involvement data. 

To do so, do the following: 

1. From the left navigation panel, click page 2. 
2. Click the Benchmark (%) chart to the right to select it. 
3. Right-click the chart and click Delete. 
4. When prompted, click Yes to confirm the deletion. 
5. Click the empty space where the chart was. 
6. Right-click and click Delete to remove this space. 

We will now display the benchmark on the remaining chart. 

7. Click the chart to select it. 
8. From the Chart tab, click Investments. 
9. Under the Show column, select the checkbox corresponding to the benchmark. 
10. Click OK. 
11. Right-click on the chart and click Show Values. 
12. Click Chart Settings and change the chart title to Product Involvement (%). 
13. Set the Font Size to 10 from the Chart tab at the top. 
14. Click Calculate. 

You are now successfully comparing the fund versus the benchmark and displaying 
their product involvement %. 

 

 

 

Exercise 9: ESG Risk - 
Product Involvement 
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Let’s now add the custom text components we saved for the Portfolio and Benchmark 
above the tables. 

To add the Portfolio title to the left table, do the following: 

1. Click the empty space above the left table to select it. 
2. In the bottom- left corner of the report windows, ensure My Components is selected. 

This will display icons for any component you may have saved on the bottom toolbar. 
3. Hover over the Text components to identify the Portfolio title component and drag and 

drop it onto the empty space. 
4. Click the empty space above the right table to select it. 
5. Repeat steps 2 and 3 with the Benchmark title component. 

The Portfolio and Benchmark titles now appear on the report. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Using saved components 
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Let’s move on to the Carbon Risk Overview page of the report.  

Just as with the Sustainability Score component on the first page of the report, you 
need to be on a recent version of Morningstar Direct to see the Carbon Metrics 
component. If you are on a lower version, you will not see the Carbon metrics chart in 
the top-left section of the report, but instead you will see a blank space, in which case 
you could add the Time Series chart component and display the Carbon Risk Score 
data point. 

In this instance we will assume that you have the most recent version and we want to 
delete the space to the right of the Carbon Metrics chart. 

To proceed, do the following: 

1. Click the empty space to the right of the Carbon Metrics chart. 
2. To remove it, press the Delete key on your keyboard. 

 

 

 

 
 
 
 
That space is now removed, and the chart takes the whole width. 

Note how the model portfolio does not have the Low Carbon DesignationTM. Its 12-
month average Portfolio Carbon Risk Score average of 9.2% meets the requirement 
(below 10% of assets), however its 12-month Fossil Fuel Involvement is just over the 
threshold with 7.3% (it should be below 7% of assets). 

The rest of the page provides us with a visual breakdown of the Low Carbon 
DesignationTM, the distribution of Carbon Risk from negligible to severe, Carbon Risk 
information and Emissions (direct and indirect) for both the portfolio and the 
benchmark. 

Let’s move on to the next page, Carbon Involvement. 
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Carbon Involvement is the level of involvement in terms of percentage of annual 
revenues in specific products and services related to Fossil Fuel. 

Just like we did with the Product Involvement page, we will display the portfolio and 
benchmark on a single chart, but this time we will change the bar chart orientation 
from horizontal to vertical.  

To proceed, do the following: 

To do so, do the following: 

1. From the left navigation panel, click page 2. 
2. Click the Benchmark (%) chart to the right to select it. 
3. Press the Delete key on your keyboard. 
4. When prompted, click Yes to confirm the deletion. 
5. Click the empty space where the chart was. 
6. Press the Delete key on your keyboard to remove this space. 
7. There are couple of other empty spaces you can remove to the left and right of the 

Portfolio (%) chart. 

We will now display the benchmark on the remaining chart. 

8. Click the chart to select it. 
9. From the Chart tab, click Investments. 
10. Under the Show column, select the checkbox corresponding to the benchmark. 
11. Click OK. 
12. Right-click on the chart and click Show Values. 
13. Click Chart Settings and change the chart title to Carbon Involvement (%). 
14. Click Calculate. 

You are now successfully comparing the fund versus the benchmark and displaying 
their carbon involvement %. 

 

 

Exercise 11: Carbon 
Involvement 
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Just as we did on the Product Involvement page, let’s now add the custom text 
components we saved for the Portfolio and Benchmark above the tables. 

To add the Portfolio title to the left table, do the following: 

1. Click the empty space above the left table to select it. 
2. In the bottom- left corner of the report windows, ensure My Components is selected. 

This will display icons for any component you may have saved on the bottom toolbar. 
3. Hover over the Text components to identify the Portfolio title component and drag and 

drop it onto the empty space. 
4. Click the empty space above the right table to select it. 
5. Repeat steps 2 and 3 with the Benchmark title component. 

The Portfolio and Benchmark titles now appear on the report. 
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The next page displays the top 25 stock holdings with their Carbon Risk, Carbon 
Exposure and Carbon Managed Risk scores, Carbon Risk Classification, and Emissions 
information 

Please note that this information will only display for company-level risk data if you 
have the appropriate licensing in place for Sustainalytics data access. 

If you do have access, you could decide to hide the cash holdings displayed in this 
component. To do so, do the following: 

7. Click the Top 25 Holdings Carbon Risk Scores table. 
8. Click Table Settings at the bottom left corner of the window. The Portfolio Holdings 

settings window opens. 
9. Under the Table tab, deselect the checkbox Include Cash Holdings. 
10. Click Calculate on the table. The cash holdings have been removed. 
11. Click the Top 25 Holdings Carbon Intensity & Emissions table. 
12. Repeat steps 2 to 4. 

 
If you do not have access to the company-level add-on, you can then remove the page 
from the report. 

5. On the left navigation panel, click on page 2. 
6. Right-click page 2 and click Delete. 
7. When prompted, click Yes to confirm the deletion. 
8. Click the Gear icon in the top-left corner of the report and click Save. 
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We now move on to the last page of the report, which displays the top 25 funds Carbon 
Risk Scores with the Carbon Risk Score, Carbon Exposure Score, Carbon Management 
Score as well as Morningstar Category and Carbon Date. 
 
 
 
 
 
 
 
 
 
 
 

Here we note that Invesco Pan Eurp has the lowest Carbon Risk Score of 7, with a 
Carbon Exposure Score of 13 and a Carbon Management Score of 49%. 

Carbon Exposure Score evaluates the level of carbon-related risk that exists in the value 
chain among companies held in the portfolio. Just like with Carbon Risk Score, the 
lower the value, the better. 

Carbon Management Score evaluates on a company's preparedness and track record in 
managing carbon operations and products and services risks that are considered 
manageable. 

 
The second part of the page displays information about Carbon Intensity and Emissions 
(direct and indirect). 

 

 

 

 

 

 

 

Looking at the same fund in the Carbon Intensity & Emissions table below, we note that 
it’s the 3rd lowest in terms of Carbon Intensity. 

Carbon Intensity measures the level of emissions a company produces compared with 
its declared revenue and is computed as follows: Total Emissions (metric tonnes of Co2) 
/ Revenue (Mil USD).  
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We can now proceed with saving the report as a template. As a reminder: 

• A report holds all the above as well as the chosen security and benchmark 
settings. 

• A template holds your chosen charts and tables, layout, font, set currency, 
colours, logos, disclaimers, custom and dynamic text. It does not hold any 
investments or benchmarks. 

1. Click the Gear icon in the top-left corner of the window. 
2. Click Save to save the report. 
3. Click the Gear icon in the top-left corner of the window again. 
4. Select Save as Template. The Presentation Studio dialogue box opens. 

 
 
 
 
 
 
 
 
 
 
 
 

5. In the Factsheet Name field, type “Model Portfolio ESG template”. 
6. Click Save. 

 
 
 
 
 
 
 
 
 
 
 
 
 
Close the report. You can now access this template from the Presentation Studio 
landing screen under My Templates and generate the same factsheet with other 
investments.  
 
 
 
 
 
 
 
 
 
 
 
 

Exercise 14: Saving a 
Template 
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Reports using Model Portfolios and Custom Benchmarks can take a lot of time to 
calculate. It is therefore advised to use the Batch function to calculate them. 

Batch Management enables the user to automate the update and export of your 
Presentation Studio reports. You then receive an email notifying you that the batch is 
completed, and you can then download the reports. 

You can create a maximum of 5 batches, with 25 reports in each. Should you require to 
extend those capabilities, please reach out to your Customer Success Manager. 

To create a batch, do the following: 

1. From the Presentation Studio landing page, click the Batch Management tile. The 
Batch Reporting window opens. 

2. From the Toolbar, click New Batch. The New Batch Setup dialogue box opens. 
3. Select Saved Reports and click Continue. The Select Reports window opens. 

 
 
 
 
 
 
 
 

4. Select “My Portfolio – ESG Scores”. 

 Note: You can use the CTRL key on your keyboard and select up to 25 reports. 

7. Click OK. The Saved Reports – New Batch Setup window opens. 
8. Select the File Format for your preferred output, PDF in this instance. 
9. Click Schedule. The Schedule window opens. 
10. Set the Start Time to 12:00. 
11. Select Repeat on the 7th day of the month. 

 
 
 
 
 
 
 
 
 
 
 

12. Click OK and then Save. 

Your batch is now set up to update your report on the 7th of every month at 12:00. 
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